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There are over 400 different built -in formulas, or Functions as they
are called, in Excel 2007. These functions enable you to create simple

Calculations Summary

to complex calculations easily and effectively. All the functions are
. . . . . 1. AutoCalculate
organized into categories to make them easy to find and they include, .
. . ; . . 2. Relative Reference
Financial, Date & Time, Math & Trig, Statistical, Lookup & Reference,
. . . . 3. Absolute Reference
Database, Text, Logical, Information, Engineering and Cube. 4 Functions
Alternatively, you can simply use the All category to view all functions ' SUM
in alphabetical order by name.
P y AVERAGE
This document covers how to insert various a functions using the MEDIAN
Insert Function button on the Formulas tab. It also covers using the MODE
AutoCalculate feature, using Relative vs. Absolute references, the Au- COUNT
toSum button, and how to create a 3D formula. MAX
MIN
TODAY
AutocCalculate NOW
You can use the AutoCalculate feature when you need to know the IF
sum of a range of values without having to add a formula to the Nested IF
Worksheet. Select any range of cells (Figure 1, 1) and Excel displays VLOOKUP
the answer on the Status Bar (Figure 1, 2). In addition to displaying HLOOKUP
the Sum of a range you can also choose between six basic functions, PMT (Payment)
such as Average, Count, Numerical Count, Minimum, and Maximum. FV (Future Value)
To use a different AutoCalculate function, right -click on the current 5. 3D Formula
answer on the Status Bar (Figure 1, 2) and select a desired function
from the shortcut menu. )
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ain @ s Excel - Advanced Calesxls [Compatibility Mode] - Microsoft Excel = x
= e x Pagmyaul Rm«n v Devper An; sum - — @ - = x
i Arial “lo AN -l &= Custom ~ ﬂ(_j ﬁ g . ?‘ [B = ﬂ ﬁ
e o | B A o) Cnaer T, | men oo o | 5 e s
Clipboard & Font {F] Number iri Styles Cells Editing
I BS -Q x| 8500/
A B ] E F G H I J K L M

World Wide Sporting Geods
Sales Report

Mar Total Sales  Expenses Net Profit  Commission

1”4 > »1] Basic Cals ~ Average - Min - Max I function ~ Lookup _“PMT - FV 1t Qtr Totals ~January . February , March .~ ¥ NI

Ready | 73 | Average: 87,500 Count:4 sum: 350000 |[EH 0

© 2008 Towson University - This work is licensed under the Creative Commons Attribution
Details available at http://www.towson.edu/OTStraining. 410

-NonCommercial -NoDerivs License.
-704 -4070.



\\«TOWSON UNIVERSITY MI CROSEXTER 0O DVAMCEIALCULATI ONS

ve Reference Ref erenc

Relative Reference

In Excel, a Relative Reference is the address of a cell, or range of cells, that changes when it is
moved, copied, or the relationship to it has changed (e.g. if you insert additional rows or columns).
For example, in a spreadsheet, a cell with a relative reference changes its formula when copied

elsewhere.
Figure 2
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A B C D E
1 |World Wide Sporting Goods
2 | Sales Report
3
4 . Sales Reps Jan Feb Mar Total Sales Notice the cell references
5 |Smith, S. 55000 69000 101000 |=SUM(B5-D5) adiust according to their
6 |Brown, N. 78000 61000 92000 =SUM(B6- D —__ | Jus 9
7 |Wallace, F. 112000 93000 99000 =SUM(BT:DT) location _vvhen you copy the
8 |Adams, G. 75000 54000 73000 =SUM(B8:D8) formula in E5 down though
9 Totals E8
10
11
12 |
Absolute Reference
Someti mes, however, in a calculation you need to anchor a ce
youo when you copy the formula to other | ocations. I'n order

reference Absolute so that the cell address does not change. To make a cell reference Absolute, you
must type a dollar sign ($) before the column reference and another dollar sign ($) before the row
reference.

You can also just press  F4 on the keyboard
and two types of mixed cell references.

T The F4 key lets you toggle between relative, absolute

@

If you press Ctrl + ~  (tilde) on the keyboard, Excel toggles between displaying the values and
formulas.
Figure 3
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reference adjusts according
to the new row, but the
second reference is
Absolute (anchored) to H1,

Total Sales

=SUM(B5:D5

Net Profit
=E5-F5

Expenses
2550

Commission

101000 =E5*5H$1

92000 =SUM(B6-D6) 2100 =E6-F6 =EF*3H$1 the commission value.
99000 =SUM(BT:D7) 1675 =E7-F7 =E7*5HS1
73000 =5UM(B8:D8) 1975 =E5-F8 =E8*§HS1
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About Functions

Formulas can be made much more efficient by using worksheet functions. There are over 400
different Functions in Excel 2007. Functions can be thought of as being made up of three parts: an
equal sign, a function name and a list of arguments enclosed in brackets. There are several ways
you can insert your functions, but the most common methods are:

Q 9 Select the Insert Function button from the  Formulas tab
I Click the Insert Function button B n the Formula bar
9 Press Shift+ F3  on the keyboard to display the Insert Function dialog box.

9 Type the function completely from scratch.

Using the Insert Function dialog box helps you fAwalk through
dialog box is designed to try and help you find the correct function. Select Insert Function button

from the Formulas tab and the Insert Function Dialog box displays. If you do not know the exact

name of the function you need, you can scroll the ALL categories list or filter the list of available

functions by selecting a specific category from the dropdown list. After you select a function and

have clicked OK, the Function Arguments dialog box displays. This is where you indicate the

arguments that are required by that function.

Figure 4

Insert Function

Search For a funckion:

Twpe a brief description of what you want to do and then click ‘ Go
Go

O select a category: |Most Recently Used F
Maost Recently Used

Select a function:

Financial
SUM Date & Time
LVERAGE Math 8 Trig
F Statistical
HYPERLIMK Lookup & Reference

COUNT Database

MAY Text

Logical L3
COMNCATENATE(text Information

Joins several kext strifEngineering [

Functions are organized
|| into categories. You can
find any function in the All
category.

Help on this Funckion (o4 l[ Cancel
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About Argument s

Arguments are part of the formulas and can be numbers, text, cell references (e.g. A1:A15), named
ranges (e.g. GradeTable), arrays, formulas or even other functions (a.k.a. Nested Functions). The
Function dialog box displays the Formula result (Figure 5, 1) so that you have an idea if you are on
the right track before accepting the formula by clicking the OK button. If you need help with any
function, click Help on this function (Figure 5, 2).

Figure 5

-

Function Arguments

AVERAGE

{96, 96, 51,79, 75}

This function requires
only one argument; a
cell range.

= 854

Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arravs, or references that
contain numbers,

NMumberl: numberl,numberz,... are 1 to 255 numeric arguments For which you want the
average.

\) o4 ] [ Cancel

Formula result = 85.4

Help on this Function /

The most commonly used function in Excel is the SUM function. The SUM function returns the total
of all the numbers in a range of cells. This formula can be typed from scratch and the cell addresses
do not need to be adjacent to each other.

Basic Concept: =SUM(numberl, number2,number3,...)

Example: =SUM(B5:B8)
Example 2: =SUM(B5,C8,D12,E15)
Figure 6
S-S EE S Excel - Ad)
Home Insert Page Layout Formulas Data Review

f ZPDE@A6 0@

Insert AutoSum Recently Financial Logical Text Date & Lookup & Math

Function ~ Used = ~ ~ ~ Time = Reference = & Trig
Function Library
| AVERAGE (» X ¢ & | =5UM(B5:B8)
4 Sales Reps ] The Sum function in this example
5 |Smith, S. 185000 169000 is adding up the numbers in cells
6 |Brown, N. {78000 {61000 B5 through BS.
7 Wallace, F. 112000 193000
8 |Adams, G. 475000 {51001
9 Totals =5
10 [SUMnumberl. [numberd], . |
11
12
13
14
15
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>
Aut oSum B«"t on

Since one of the most common tasks for spreadsheets is to sum a range of values, Excel has a

special button that helps you do just that. The AutoSum button is on the Formulas tab and also on

the Home tab. As step one, before you click the AutoSum button, it is recommended that you select
the cell where you want the answer. When you click on the AutoSum button, the Sum function and a
suggested range to be added are displayed and highlighted in the formula bar. You can change this
range if it is not correct by either typing or drag -selecting the correct range.

If you click the down arrow on the AutoSum button, you can also use other commonly used
Functions such as AVERAGE, COUNT NUMBERS, MAX, MIN.

AVERAGE Functi on

Another common calculation in Excel is the AVERAGE function (Figure 7, 1). The AVERAGE function
is a Statistical function which returns the arithmetic mean of a list of values. In other words, it adds
up the total value of all the cells selected and divides it by the number of cells selected.

Basic Concept: =AVERAGE(number 1, number 2, number 3, é)
Example: =AVERAGE(B6:F6)

MEDI AN Functi on

Another type of statistical function is the MEDIAN function (Figure 7, 2). The MEDIAN function
returns the middle of a distribution (half the scores are above the median and half are below the
median) of all the numbers evaluated by the formula.

Basic Concept: =MEDIAN(numberl, number2, number3,...)

Example: =MEDIAN(B6:F6)

MODE Functi on

A third type of statistical function is the MODE function (Figure 7, 3). The MODE function returns the
most common or frequent value in a data set.

It is possible that there is no match and Excel displays #N/A (Figure 7, 1).
Basic Concept: = MODE(numberl, number2, number3,...)

Example: =MODE(B6:F6)

COUNT NUMBERS Function

A fourth type of statistical function is the COUNT NUMBERS function (Figure 7, 4). The COUNT
NUMBERS function counts the total number of cells that contain numbers or data.

Basic Concept: =COUNT (valuel, value2,...)

Example: =COUNT(B6:B17)
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MAX Functi on

Another type of statistical function is the MAX function (Figure 7, 5). The MAX function returns the
largest (maximum) value of all the numbers evaluated by the formula.

Basic Concept: =MAX(number 1, number 2, number 3, é)

Example: =MAX(B6:B17)

Another type of statistical function is the MIN function (Figure 7, 6). The MIN function returns the
smallest (minimum) value of all the numbers evaluated by the formula.

Basic Concept: =MI Nnumber 1, number 2, number 3, é)
Example: =MIN(B6:B17)
Figure 7
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[ 1 | Final Grade
[ 2 100

3 a0 The formulas below are all using the grades
[ 4 | 05 < listed in cells A2 through A8. Each formula
5 a0 provides a different statistical answer.
6 7
[ 7 75

a2 b5
B
(10
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TODAY Functi on

The Today function is a volatile Date and Time function that returns the current date. This function
will update the date each time the file is opened or saved. This function does not require any
arguments, but you must still include the empty parentheses after the function name (Figure 8, 1).

Basic Concept/Example: =TODAY()

It is probably quicker to type the TODAY function from scratch. If you do, make sure you include the
open and closed parenthesis after the function name T no argument is needed for this function.

NOW Functi on

The NOW function returns the current date and time. This function will update the date each time
the file is opened or saved. This function does not require any arguments, but you must still include
the empty parentheses after the function name.

Basic Concept/Example: =NOW()

Similar to the TODAY function, it is also quicker to type the NOW function from scratch. If you do,
make sure you include the open and closed parenthesis after the function name T no argument is
needed for this function.

Figure 8

.-/:;\‘.l = AR L e E ) - Excel - Advanced Calcsxls [Compatibility Mode] - Microsoft Excel
e
—/ Home Insert Page Layout Formulas Data Review View Developer Add-Ins et Started

* [ A ||| = gll"&“ | =) Wrap Text

53 ; ST ~
Pajte 7 /B £ U - @ &A= == =|| = Merge & Center - ||| $ ~ %o |[%8 356 al aFTIa':Tt s{_fell
Clipboard ™ Font Alignment MNumber Sty!gs,,

AVERAGE + (> % & f] =today{)

A B c D E F G H
1 Mr John Smith
2 Math 103 Final Grade Date:|=today() |
3
4
Average per Student

5 Student Name Test 2 Test 3 Homework (Arithmetic Mean) Media
6 Alex 96 96 81 79 75
T | Bethany N 85 N 86 100
8 | Brittany 81 87 84 81 100
9 | Chrystal 98 89 88 88 75
10 Danielle 89 89 88 a7 95
11 Frank 98 83 83 i 100
12 Heather 96 90 90 89 75
13 |Jamie 92 82 81 79 92
14 Kim 81 85 83 80 100
15 Matt 75 82 79 75 75
16 Ron 82 85 84 82 65
17 | Stephanie 98 92 95 89 100

18 | Highest Grade
19 | Lowest Grade
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|l F Functi on

The IF function is a Logical function that is designed to return one value if a condition you specify
evaluates to be TRUE and another value if it evaluates to be FALSE. In other words, the function can
only give one of two possible answers. For example, if you exceed the sales quota, you get a bonus,
if not, you get nothing; or as shown in Figure 9, if the value in the cell E7 is greater than cell F7,
multiply cell E7 by 10%, or display O (zero).

Basic Concept: =IF(logical_test, value_if true, value_if_false)

Example: =IF(E7>F7,E7*0.1,0) )
Figure 9
When using the Insert Function dialog box,
notice the formula is entered in the formula
/ bar as well as in the selected cell.
Nested I F Function

A Nested function is simply a function within another function. The result returned from one function
is used as the argument of another function. A nested formula can contain up to seven levels of
arguments and do not need to be IF functions.

Basic Concept: =IF(logical_test,=IF(logical_test, value_if true, value_if_false))

Example: =IF(19=1,H9*0.1,IF(19=2,H9*0.08,H9*0.07))




